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P R E F A C E

             
Getting Help
You can find answers to most questions about how to use your computer and the Mac OS in 
the Help Center, available in the Help menu at the top of your screen.
Look here for
information about your
computer and software

applications you’ve
installed.

Look here for information 
on the system software.
Normally, you won’t have problems with your computer. If you do experience problems with 
the computer, do the following:
m Open the Help menu and choose Mac OS Help.

If your Help menu doesn’t include Help Center and Mac OS Help, open the Application 
menu in the top-right corner and choose Finder. Then open Mac OS Help.

m If the Help menu isn’t available or you can’t find what you’re looking for in 
Mac OS Help, use this book to help you solve the problem. 

m Chapter 1 contains a list of problems and solutions.

m Chapters 2 through 4 contain detailed information on important tasks—starting up 
from a CD, testing and repairing your hard disk, and reinstalling your computer’s 
software. You may need to do one or more of these tasks to solve the problem.

m If nothing in the first four chapters solves your computer’s problem, please refer to 
Chapter 5, “Contacting Apple for Help,” on page 45.

Your Application menu may look 
different, depending on the 
applications you have open.
7





   

C H A P T E R

 

1

                                      
1 Solving Problems
 

Problems

Computer Won’t Start Up

Computer won’t start up

m Make Sure Your Computer Is Getting Power (p. 14)

m Make Sure the Monitor Is Properly Connected and Adjusted (p. 15)

m Make Sure External Equipment Is Properly Connected and Turned On (p. 15)

m Increase the Memory Available for System Software (p. 18)

m Make Sure You’re Using the Correct Disk as the Startup Disk (p. 19)

m Resolve System Extension Conflicts (p. 20)

m Reset the PRAM (p. 22)

m Make Sure Memory and Expansion Cards Are Installed Correctly (p. 22)

m Replace the Computer’s Backup Battery (p. 23)

Unusual sound occurs when you try to start up the computer

m Make Sure External Equipment Is Properly Connected and Turned On (p. 15)

m Make Sure Memory and Expansion Cards Are Installed Correctly (p. 22)

m See Chapter 3, “Testing and Repairing Your Hard Disk,” on page 27.

Computer Won’t Restart

m Quit Open Applications (p. 13)

m Force Your Computer to Restart (p. 13)

Computer Won’t Shut Down

m Force Your Computer to Shut Down (p. 14)
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You Hear Tones When Starting Up

If you hear one or more tones when you attempt to start up your computer, this typically 
indicates a problem with the computer’s hardware.

m One tone:  Your computer doesn’t detect any memory in your system. See “Make Sure 
Memory and Expansion Cards Are Installed Correctly” on page 22.

m Two tones:  Your computer detects incompatible memory. See “Make Sure Memory and 
Expansion Cards Are Installed Correctly” on page 22.

m Three or more tones:  Contact an Apple-authorized service provider. See the service and 
support information that came with your computer.

Screen Shows Single Folder With Blinking Question Mark

m Make Sure External Equipment Is Properly Connected and Turned On (p. 15)

m Resolve SCSI ID Conflicts (p. 17)

m Re-Bless the System Folder (p. 18)

m Make Sure You’re Using the Correct Disk as the Startup Disk (p. 19)

m Resolve System Extension Conflicts (p. 20)

m Reset the PRAM (p. 22)

m See Chapter 3, “Testing and Repairing Your Hard Disk,” on page 27.

m See Chapter 4, “Reinstalling Your Computer’s Software,” on page 33.

Computer Freezes or a System Error Message Appears

m Take Notes (p. 12)

m Quit Open Applications (p. 13)

m Make Sure External Equipment Is Properly Connected and Turned On (p. 15)

m Make Sure You’re Using the Correct Disk as the Startup Disk (p. 19)

m Resolve System Extension Conflicts (p. 20)

m See Chapter 3, “Testing and Repairing Your Hard Disk,” on page 27.

m See Chapter 4, “Reinstalling Your Computer’s Software,” on page 33.

Keyboard or Mouse Doesn’t Work

m Take Notes (p. 12)

m Make Sure External Equipment Is Properly Connected and Turned On (p. 15)

m Resolve System Extension Conflicts (p. 20)

m See Chapter 3, “Testing and Repairing Your Hard Disk,” on page 27.

m See Chapter 4, “Reinstalling Your Computer’s Software,” on page 33.
 



 

 

                                                    
Message Appears

Sometimes a message appears on the screen telling you that a problem occurred.

Message says there’s not enough memory

Note:  These solutions are for system software memory problems. For problems with 
application memory, see Mac OS Help (available in the Help menu).

m Increase the Memory Available for System Software (p. 18)

m Check RAM Disk Settings in the Memory Control Panel (p. 17)

m Resolve System Extension Conflicts (p. 20)

Message appears about disk corruption

m Take Notes (p. 12)

m Check RAM Disk Settings in the Memory Control Panel (p. 17)

m See “Repairing the Directory on Your Disk” on page 27.

Message appears about the LocalTalk port

m Make Sure External Equipment Is Properly Connected and Turned On (p. 15)

Normal Desktop Doesn’t Appear

Screen is dark

m Wake Up Your Computer (p. 13)

m Make Sure Your Computer Is Getting Power (p. 14)

m Make Sure the Monitor Is Properly Connected and Adjusted (p. 15)

m Reset the PRAM (p. 22)

Screen is gray or blank

m Reset the PRAM (p. 22)

Empty flashing box appears

m Re-Bless the System Folder (p. 18)

m See Chapter 3, “Testing and Repairing Your Hard Disk,” on page 27.

m See Chapter 4, “Reinstalling Your Computer’s Software,” on page 33.

Large folder-shaped areas containing pictorial buttons appear

m Make Sure You’re Using the Correct Disk as the Startup Disk (p. 19)

Hard Disk Icon Doesn’t Appear on Desktop

m Quit Open Applications (p. 13)

m Restart Your Computer (p. 13)

m Make Sure External Equipment Is Properly Connected and Turned On (p. 15)
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m Resolve SCSI ID Conflicts (p. 17)

m See Chapter 3, “Testing and Repairing Your Hard Disk,” on page 27.

Computer Starts Up From Wrong Disk

m Make Sure External Equipment Is Properly Connected and Turned On (p. 15)

m Resolve SCSI ID Conflicts (p. 17)

m Make Sure You’re Using the Correct Disk as the Startup Disk (p. 19)

m Reset the PRAM (p. 22)

m See Chapter 3, “Testing and Repairing Your Hard Disk,” on page 27.

PowerBooks: Sleep Indicator Light Glows Steady Green

m Quit Open Applications (p. 13)

m Make Sure Your Computer Is Getting Power (p. 14)

m Restart Your Computer (p. 13)

Disc Is Jammed

m Remove a Jammed Disc (p. 20)

Solutions

Take Notes

If you see an error message or the screen freezes, you don’t have to take action immediately. 
First, note the following information:

m the error message and its ID number (if any)

m what you were doing when the problem occurred

m the programs you were using

m software you have installed recently (especially items that have been added to the System 
Folder)

m hardware you have added internally to your computer (such as memory)

m devices that are connected to your computer

m clues on the screen—is a menu selected? What programs and document icons are open? 

m anything else that seems relevant
Important  If you were typing text, write down any text still visible on the screen so that 
some of your work will be easy to replace.
 



 

 

                                 
Wake Up Your Computer

If your screen is dark, a screen saver program may have darkened your screen, or the 
computer or monitor may have “gone to sleep” (to save energy) because it was inactive. Turn 
off the screen saver by pressing a key or moving the mouse.

You may want to adjust the settings in the Energy Saver control panel to determine when 
your screen and computer go to sleep. For more information, see Mac OS Help (available in 
the Help menu).

Quit Open Applications

If your computer freezes, you can sometimes recover by quitting open applications. You can 
quit almost any application by pressing Command (x)-Q.

Force an Application to Quit

If you can’t quit an application in the normal way, try forcing the program to quit by 
simultaneously pressing the keys Command (x), Option, and Esc. In the dialog box that 
appears, click Force Quit.

Note:  Unsaved changes in your current documents will be lost.

Immediately quit all other open programs and restart your computer.

Restart Your Computer

Often you can eliminate a problem simply by restarting your computer, which clears the 
computer’s memory. Before you restart, make sure you save any open documents.

Always try restarting the proper way:

m Open the Special menu and choose Restart.

On some computers, you can also press the Power button (®) on the keyboard or on the 
computer, then click Restart in the dialog box that appears.

Force Your Computer to Restart

If you are unable to restart your computer in the normal way, try the following:

m Simultaneously press the Command (x) and Control keys and the Power button (®) on 
your keyboard or on your computer.

m If that doesn’t work, do one of the following:

m If your computer has a Reset hole, carefully insert the end of a straightened paper clip 
into the Reset hole on your computer and push gently. Remove the paper clip. Your 
computer should restart. For the location of the Reset hole, see the documentation 
that came with your computer.

m If your computer has a Reset button, press it. For the location of the Reset button, see 
the documentation that came with your computer.
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Note:  Some PowerBooks don’t have a Reset button. In that case, simultaneously press 
the Shift, Function (Fn), and Control (ctrl) keys and the Power button (®). Wait at least 
30 seconds, then turn your PowerBook on again by pressing the Power button (®).

m If resetting doesn’t work, unplug the computer. Wait at least 30 seconds, then reconnect 
the power plug. Turn your computer on again by pressing the Power button (®) on the 
keyboard or on the computer.

Shut Down the Computer

Always try shutting down your computer the proper way:

m Open the Special menu and choose Shut Down. 

You can also press the Power button (®) on the keyboard or on the computer, then click 
Shut Down in the dialog box that appears.

Force Your Computer to Shut Down

If you are unable to shut down your computer in the normal way, do one of the following:

m Press the Power button (®) on the computer.

m If your computer has a Reset hole, carefully insert the end of a straightened paper clip 
into the Reset hole on your computer and push gently. Remove the paper clip. Your 
computer should restart. For the location of the Reset hole, see the documentation that 
came with your computer. Then, shut down your computer in the normal way (open the 
Special menu and choose Shut Down).

m If your computer has a Reset button, press it. For the location of the Reset button, see the 
documentation that came with your computer. Some PowerBooks don’t have a Reset 
button. In that case, simultaneously press the Shift, Function (Fn), and Control (ctrl) keys 
and the Power button (®). Wait at least 30 seconds, then turn your PowerBook on again 
by pressing the Power button (®).

If that doesn’t work (or if your computer doesn’t have a Power button), and your computer is 
plugged into a power strip that has an on/off switch, turn the switch off. If there isn’t an on/
off switch, unplug your computer. Wait at least 30 seconds before turning your computer 
back on again.

Make Sure Your Computer Is Getting Power

m Make sure the keyboard and mouse cables are properly connected.

m If your computer and monitor are separate, make sure the external cables are properly 
connected.

m Make sure the power cord is plugged into a working outlet. If it’s plugged into a power 
strip, make sure the power strip is turned on. 

m If you have a PowerBook:

m Make sure the battery is properly seated in its compartment. 
 



 

 

                               
m The battery may be drained. Make sure you plugged in the power adapter and that the 
power adapter is firmly connected to both the computer and a power source. If the 
power adapter is plugged into a power strip, make sure the power strip is plugged into 
a working outlet and turned on. Let the battery recharge for a few minutes.

m If you’re using the power adapter, it should get warm after being plugged in for 10 
minutes. If it remains cold, make sure the adapter is securely plugged in and attached 
to the power cord. 

Make Sure the Monitor Is Properly Connected and Adjusted

m Check that the monitor’s brightness (¤) and contrast (O) controls are adjusted 
properly.

m Turn off your computer. For external monitors, check that the monitor cable is firmly 
connected and that the monitor is plugged in and turned on.

m If you are using a monitor adapter between the monitor and computer, make sure the dial 
and DIP switches (if any) are set properly for the monitor. For more information, see the 
documentation that came with the monitor or adapter.

m If possible, borrow a monitor that you know works with another Mac OS–based computer 
and connect it to your computer. If the borrowed monitor works, then your monitor may 
need repair. Consult an Apple-authorized service provider.

Note:  If you are displaying video from your computer on a television screen or displaying 
video from a PowerBook on an external monitor without video mirroring, it may be normal 
for the computer screen to be dark. See the documentation that came with your computer 
for information.

Make Sure External Equipment Is Properly Connected and Turned On

m Make sure all cables and connectors are in good working order. Check for bent or missing 
pins on the connectors. Make sure the cables connecting the device are not frayed or 
damaged. If they are, you need to replace them. See an Apple-authorized service provider.

m Make sure connectors are plugged in all the way. Try unplugging connectors on all of the 
devices, then plugging them back in.

m If a device has thumbscrews, make sure the thumbscrews are secure.

m If a device has a power cord, make sure the cord is plugged into a working electrical 
outlet.

m If you’re using a SCSI (Small Computer System Interface) device, make sure the 
terminators are secure and their clips are fastened. For more information, see the 
documentation that came with the device. Disconnect older SCSI devices if you are also 
using SCSI-2 or newer devices. Older disks, which are usually under 200 megabytes (MB) 
in size, can have problems when they are connected to a SCSI bus to which SCSI-2 or 
newer devices are also connected.
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m Make sure all devices are turned on and ready to use.

m If you are connected to an Ethernet network, check the settings in the AppleTalk control 
panel to make sure that Ethernet is selected. Your computer may not start up because of 
heavy network traffic. Disconnect the Ethernet cable, then start up again. Reconnect the 
Ethernet cable after the computer starts up. (It’s okay to connect and disconnect an 
Ethernet cable while your computer is on.) 

For USB devices:

If you’re still having problems with one or more USB devices, do the following:

m Plug the device into another USB port on your computer or into the USB port on another 
device that is plugged into a power outlet (such as a self-powered hub).

m If the device is connected to a hub, try unplugging one or more devices from the hub. 

m If the device is connected to a self-powered hub (a hub that has a power cord), make sure 
the cord is plugged into a working electrical outlet.

m Unplug all USB devices from your computer except the Apple USB keyboard and Apple 
USB mouse. Plug one device in at a time to determine which device is the problem. Once 
you determine which device is causing the problem:

m There may be something wrong with the cable connecting the device. If possible, 
borrow a cable that you know works with another similar device. Connect the cable to 
the device, then connect the device to your computer. Start up your computer. If the 
device works using the borrowed cable, then you need to replace the cable. Contact 
the device manufacturer or an Apple-authorized service provider.

m Refer to the documentation that came with the device. Also see the information on 
connecting equipment in the online documentation that came with your computer.

m If you suspect a mouse problem, clean your Apple USB mouse as described in the online 
documentation that came with your computer. Then, plug the mouse into an open USB 
port on your computer. If the mouse works, then you may have a problem with the 
keyboard. If the mouse doesn’t work, borrow an Apple USB mouse from another 
computer and connect it to yours. If that solves the problem, you may need to repair your 
mouse. Consult an Apple-authorized service provider.

m If you suspect a keyboard problem, borrow an Apple USB keyboard from another 
computer and connect it to yours. If that solves the problem, you may need to repair your 
keyboard. Consult an Apple-authorized service provider.

For non-USB devices:

If you’re still having problems with one or more non-USB devices, do the following:

m Shut down your computer by pressing the Power button (®) on your Apple USB 
keyboard or on the front of the computer. When a dialog box appears, click Shut Down. 
Reconnect all external devices and turn them on. Then restart your computer.
 



 

 

              
m If that doesn’t solve your problem, shut down your computer again. Turn off and 
disconnect all external equipment, except your keyboard and mouse. To determine which 
piece of equipment may be causing the problem, reconnect one device, turn it on (if 
necessary), and start up your computer. Continue reconnecting devices one at a time, 
starting up, verifying the devices work, and shutting down until you determine which 
device is causing the problem. Once you determine which device is causing the problem:

m There may be something wrong with the cables connecting the device. If possible, 
borrow a cable that you know works with another similar device. Connect the cable to 
the device, then connect the device to your computer. Start up your computer. If the 
device works using the borrowed cable, then you need to replace the cable. Contact 
the device manufacturer or an Apple-authorized service provider.

m Refer to the documentation that came with the device.

m Refer to the documentation that came with your computer to make sure you are 
connecting the device properly.

Resolve SCSI ID Conflicts

If your computer uses SCSI (Small Computer System Interface) devices, make sure each 
device has a unique ID number from 0 to 7. Some computers have two separate SCSI chains, 
each with its own set of ID numbers.

Make sure that the SCSI chain is properly terminated. The last device in each SCSI chain 
must be terminated. Your computer, which is the first SCSI device, is already terminated 
inside.

See the documentation that came with your computer and SCSI equipment for specific 
details on setting SCSI ID numbers and terminating SCSI devices.

Check RAM Disk Settings in the Memory Control Panel

Note:  In most cases, you should leave the RAM disk turned off, unless you have a specific 
need for it. 

If you’re using a RAM disk and you see a disk corruption message, click Cancel to close the 
message. Check the RAM disk settings in the Memory control panel to make sure that you 
aren’t trying to create a RAM disk larger than the amount of available memory on your 
computer or the amount of free space on your hard disk. Leave enough memory available for 
use by your system software and any applications you open. Make sure there is also enough 
free space on your hard disk. When you shut down your computer, the contents of the RAM 
disk are copied to the hard disk.
Solving Problems 17
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Increase the Memory Available for System Software

If you’re having trouble starting up your computer, there may not be enough memory to 
load all the system software extensions you’ve installed. Restart the computer, holding down 
the Shift key until you see the message “Extensions Disabled” in the “Welcome to Mac OS” 
box. Then try the following:

m Turn on (or increase) virtual memory in the Memory control panel. Your computer will 
perform well with virtual memory set up to twice the amount of RAM in the computer; for 
best performance, limit virtual memory to 1.5 times the amount of RAM.

m Reduce the size of the disk cache in the Memory control panel. Start by using the default 
setting. Do not set the disk cache below 256K.

m If you use a RAM disk, reduce its size or turn it off in the Memory control panel.

m Use the Extensions Manager control panel to turn off extensions. To help you determine 
which extensions you may want to turn off, in the Extensions Manager control panel, click 
the arrow next to “Show item information.” Then click an item in the list. You can also use 
the Extensions Manager to create different sets of extensions for special situations.

You need to restart the computer for these changes to take effect. See Mac OS Help 
(available in the Help menu) for more information about using virtual memory, a RAM disk, 
and the Extensions Manager.

If the problem persists, try performing a clean installation of system software. See 
“Performing a Clean Installation” on page 36.

If none of these suggestions work, you may need to install additional memory (RAM) in your 
computer. For more information, see the documentation that came with your computer.

Re-Bless the System Folder

If your computer is not recognizing the system software, the System Folder may need to be 
“re-blessed.” If the System Folder is “blessed,” the Mac OS logo is on the folder’s icon.
1 Start up your computer from the software install CD.
See Chapter 2, “Starting Up From a CD,” on page 25.
2 Open the System Folder on your hard disk.

3 Double-click the System file.
If you are unable to open the System file, you may need to reinstall the system software. See 
Chapter 4, “Reinstalling Your Computer’s Software,” on page 33.
4 After the System file opens, close the file and System Folder windows and restart your 
computer.
 



 

If this doesn’t work, try the following:
1 Start up your computer from the software install CD.
See Chapter 2, “Starting Up From a CD,” on page 25.
2 Drag the System file out of the System Folder to another location on your hard disk (the 
desktop is locked).

3 Close the System Folder.

4 Put the System file back into the System Folder. 
Make Sure You’re Using the Correct Disk as the Startup Disk

At least one disk drive must have system software on it from which the computer can start 
up. Most computers have an internal hard disk that is used as the startup disk. 

m Specify the startup disk by using the Startup Disk control panel. See Mac OS Help 
(available in the Help menu) for instructions.

m For information on starting up using a CD, see Chapter 2, “Starting Up From a CD,” on 
page 25.

m If you don’t want your computer to start from a CD, press the CD Eject button to open 
the tray, remove the disc, then close the tray. If the tray won’t open, see “Remove a 
Jammed Disc” on page 20.

m If the startup disk is an external hard disk, check that it is turned on and that its cable is 
properly connected. 

m If large folder-shaped areas containing pictorial buttons appear when you start up, you 
probably started up from a CD containing At Ease or you have At Ease turned on. At Ease 
is an alternative to the Macintosh desktop. You can specify the startup disk by using the 
Startup Disk control panel. See Mac OS Help (available in the Help menu) for 
instructions. To turn At Ease off, see the documentation that came with the software.

m If the hard disk has been initialized for use as a RAID volume, you won’t see an icon for it 
on the desktop until you create at least one RAID volume on that disk. Refer to the 
documentation that came with the RAID software for more information.
Solving Problems 19
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Remove a Jammed Disc

The normal way to eject a CD is to drag its icon to the Trash. 

If a CD or DVD disc is jammed, shut down your computer. Locate the emergency ejection 
hole near the disc drive’s opening. (For more information, see the documentation that came 
with your computer.) Carefully insert the end of a straightened paper clip and push gently 
but firmly until the tray is released, then pull the paper clip out. Carefully pull the tray open 
and remove the disc. Do not use excessive force. ( Your drive may not look exactly as shown.)

If the disc is still stuck in the drive or won’t come out of the drive easily, you’ll need to 
contact an Apple-authorized service provider. See the service and support information that 
came with your computer.

Resolve System Extension Conflicts

System extensions are small programs that add to or extend the capabilities of your 
computer’s system software. These programs reside in one of two folders in the System 
Folder:

m Extensions folder

m Control Panels folder

The term “extension” refers to items in either folder.

If your computer does not start up properly or behaves erratically, you may have an 
extension that is not compatible with another extension, or with an application or system 
software.

Verify the Problem

To verify that you have a compatibility problem:
1 Make sure the Caps Lock key is not engaged.

2 Start up your computer while holding down the Space bar.

3 Release the Space bar when the Extensions Manager control panel opens.
Note:  If the Extensions Manager control panel doesn’t open after a few minutes, restart the 
computer holding the Shift key down, so all extensions are turned off. Then open the 
Extensions Manager control panel and continue with the steps below.
 



4 Make a note of the name of the currently selected set of extensions in the Selected Set pop-
up menu so that you can return to it later if you want.

5 Open the Selected Set pop-up menu and choose Mac OS 8.5 Base.

6 Click the Continue button to continue startup.

7 When the computer is ready, try the same actions that caused the problem.
 

If the problem no longer occurs, you probably have one or more extensions or control 
panels that has corrupted preferences, is corrupted itself, or doesn’t work with Mac OS 8.5. 
Continue with the steps in the next section.

Test Individual Extensions and Control Panels

A recently installed extension or control panel might be the problem. If you have a lot of 
extensions and control panels, you may want to “work by halves.” Turn on half the extensions 
and control panels and test for the problem. If the problem disappears, repeat the process 
turning on half of the remaining items. If the problem persists, repeat the process turning off 
half of the items that are turned on. Continue to work by halves like this until you locate the 
conflicting extensions or control panels.
1 Make sure the Caps Lock key is not engaged.

2 Restart your computer while holding down the Space bar.

3 Release the Space bar when the Extensions Manager control panel opens.
Note:  If the Extensions Manager control panel doesn’t open after a few minutes, restart the 
computer holding the Shift key down, so all extensions are turned off. Then open the 
Extensions Manager control panel and continue with the steps below.
4 Open the Selected Set pop-up menu and choose the desired set of extensions you want to 
test.

5 Click the Duplicate Set button to create a new set of extensions. In the dialog box that 
appears, type a name for the set (for example, “Test Set”) and click OK.

6 Turn off all the extensions in the new set by opening the Select Set menu and choosing All 
Off.

7 Turn on the item you want to test by clicking its checkbox.

8 Click the Continue button to continue startup.

9 Try the same actions that caused the problem.
If the problem occurs again, the item is probably incompatible. Remove the item from the 
Extensions or Control Panels folder or turn the item off using the Extensions Manager.
10 Restart your computer while holding down the Space bar to open the Extensions Manager. 
Turn on the next item you want to test. Repeat this step until you’ve located the extension 
that is causing the problem.
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Note:  If the Extensions Manager control panel doesn’t open after a few minutes, restart the 
computer holding the Shift key down, so all extensions are turned off. Then open the 
Extensions Manager control panel and continue with the steps below.

Once you find that a piece of software is incompatible, try the following:

m Delete its preferences file, if it has one; it may be corrupted. Then restart your computer.

m Reinstall the extension and restart your computer.

m Contact the manufacturer of the extension to see if an updated version is available.

Reset the PRAM

Your computer stores information in an area of memory called parameter RAM, or PRAM 
(pronounced “PEA-ram”). Resetting the PRAM replaces the information stored there with the 
default (original) settings. 
Important  When you reset the PRAM, preferences for the Memory and AppleTalk control 
panels are lost. Make a note of the settings in these control panels before you reset PRAM. 
Some third-party software programs also store information in PRAM. You may have to 
reconfigure video cards after resetting PRAM, and other aspects of your work may be 
affected.
To reset PRAM, follow these steps:

Note:  This procedure may not work with some keyboards from manufacturers other than 
Apple.
1 Make sure the Caps Lock key is not engaged.

2 Start up or restart your computer and immediately hold down the Command (x), Option, P, 
and R keys. 

3 Keep holding down the keys until you hear the startup sound a second time, then release the 
keys. 

4 If you had special settings in any control panels, open those control panels to reset the 
desired settings.
Make Sure Memory and Expansion Cards Are Installed Correctly

If you’ve recently installed RAM, make sure you’ve used the correct type of memory for your 
computer. For more information, see the memory specifications in the documentation that 
came with your computer.

If you recently installed RAM or an expansion card in your computer, check the installation 
information in the documentation that came with your computer to make sure the memory 
or card is properly installed. If you purchased an expansion card from a manufacturer other 
than Apple, contact the manufacturer if you need further help.
 



 

Replace the Computer’s Backup Battery

If you have intermittent problems starting up your computer and the date is reset to 
something other than the current year, you need to replace the backup battery in your 
computer. 

For some computers, you can replace the battery yourself. For others, you must have an 
Apple-authorized service provider do this for you. To find out if your computer’s battery is 
user-replaceable, see the documentation that came with your computer. 
Important  Batteries contain chemicals, some of which may be harmful to the environment. 
Please dispose of used batteries according to your local environmental guidelines.
Replacing the battery may affect the settings in some of your control panels, including the 
following:

m Date & Time

m Memory (information lost includes RAM disk settings)

m Monitors & Sound

m Keyboard and Mouse (or Trackpad)

m AppleTalk (“Connect via” is set to the Ethernet port)

m Map

Make a note of the settings before you replace the battery. You may also have to restore 
modem settings in any communications software programs you are using.
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Summary of Useful Keyboard Combinations
To do this... ...press this key combination

Force the computer to restart Command (x)-Control-Power (®)

Force your PowerBook to 
reset1

Shift-Function (Fn)-Control (ctrl)-Power (®)

Start up your computer from a 
CD or DVD

Start up or restart your computer with the C key held down.

Disable all extensions Start up or restart your computer with the Shift key held down.

Turn off selected extensions 
using the Extensions Manager 
control panel

Start up or restart your computer with the Space bar held down.

Force a program to quit Command (x)-Option-Esc

Reset the PRAM 
(parameter RAM)

Start up or restart your computer holding the 
Command (x)-Option-P-R keys down.

Cancel the task the computer 
is working on

Command (x)-.(period)

1 For PowerBooks that do not have a reset button
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2 Starting Up From a CD
 

To install or remove system software on a hard disk, or to initialize a hard disk, you need to 
start up your computer from a CD-ROM disc that contains system software, such as your 
software install or software restore CD. 

Starting Up From a CD

When starting up from a CD, make sure you use a CD that contains system software.
1 Turn on your computer if it’s not already on.

2 Press the CD Eject button on the front of the CD drive to open the tray.

3 Place the CD in the tray with the disc label facing up.
Make sure the disc is lying flat in the tray.
4 Gently push the tray in to close it.

5 Make sure the Caps Lock key is not engaged.

6 Hold down the C key on your keyboard while you choose Restart from the Special menu.

7 When you see the screen that says “Mac OS” and the phrase “Starting Up,” release the C key.
In a few seconds the desktop appears. The CD icon appears at the top-right corner of the 
desktop (above your hard disk icon), and the Apple (K) menu does not contain the usual 
items.

Note:  The desktop pattern will be different from the pattern you normally see, since your 
computer is now using the system software that’s on the CD. Your regular desktop pattern 
will reappear when you start up from your normal startup disk. 

If the above procedure doesn’t work, make sure the CD is inserted properly, restart the 
computer, and hold down the Command (x), Option, Shift, and Delete keys (to temporarily 
disable the hard disk). Hold the keys down until you see the screen that says “Mac OS” and 
the phrase “Welcome to Mac OS.”
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When You’re Finished With the CD

When you start up your computer from a CD, the CD cannot be ejected in the usual way (by 
dragging the CD icon to the Trash). To restart your computer from the hard disk and eject 
the CD, do one of the following:

m Choose Restart from the Special menu. Immediately after hearing the startup chime, 
press the CD Eject button on the front of the CD drive. Remove the CD and store it in a 
safe place. Gently push the tray in to close it.

m Open the Startup Disk control panel, select the hard disk, then close the control panel. 
Restart your computer. After startup, drag the CD icon to the Trash (or choose Put Away 
from the File menu). When the CD tray opens, remove the CD and store it in a safe place. 
Gently push the tray in to close it.

Selecting the CD Drive as Your Startup Disk

If you want to start up from a CD, you can choose the CD drive as the startup disk in the 
Startup Disk control panel. To do this, follow these steps:
1 Insert a CD disc into the CD drive on your computer.

2 Open the Startup Disk control panel.

3 Click the CD icon, then close the control panel.
Your computer will now start up from the CD until you change the startup disk.
 



C H A P T E R

3

3 Testing and Repairing Your Hard Disk
 

If you see a message reporting that your hard disk is “damaged” or unreadable, the directory 
on your hard disk may have become corrupted.

Data can be corrupted

m any time the computer is not shut down properly

m when your computer freezes or crashes

m if you’re using SCSI devices that are not properly connected and terminated

m if you’re using SCSI devices that are properly connected to your computer but not on 
when the computer starts up

Repairing the Directory on Your Disk

Most problems with your hard disk’s directory can be fixed easily with Disk First Aid.
1 Make sure the Caps Lock key is not engaged.

2 Start up your computer from the software install CD. (See Chapter 2, “Starting Up From a 
CD,” on page 25.)

3 Locate the Utilities folder on the CD and double-click it to open the folder.

4 Double-click the Disk First Aid icon to open the program.
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5 Click the icon of the disk you want to test. 
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Note:  Depending on the type of computer you have, your screen may look slightly different.
6 Click Repair to begin testing and repairing the disk.
If Disk First Aid Cannot Correct the Problem

m Try running Disk First Aid a second or third time. Sometimes repeating the process 
corrects the problem.

m Use the Drive Setup utility to update the driver. See “Updating the Hard Disk Drivers,” 
next.

m Use another disk repair or recovery program. Sometimes another program will help you 
recover a corrupted disk.

Note:  Before using software from a manufacturer other than Apple, see the 
documentation that came with the software or contact the software manufacturer to 
make sure the program is compatible with your computer and the version of Mac OS 
installed on your computer. Apple cannot guarantee the performance of software from 
manufacturers other than Apple.

m If that doesn’t work, you may need to reinitialize the hard disk (see “Initializing a Hard 
Disk” on page 30).

Updating the Hard Disk Drivers

Some problems with your hard disk can be fixed by updating the driver. Use the Drive Setup 
program that came with your computer in the Utilities folder on your hard disk, and on the 
software install CD.
 



1 Make sure the Caps Lock key is not engaged.

2 Start up your computer from the software install CD. (See Chapter 2, “Starting Up From a 
CD,” on page 25.)

3 Locate the Utilities folder on the CD and double-click it to open the folder.

4 Double-click the Drive Setup icon to open the program.
 

5 In the list of drives, select the disk you want to update.
Note:  Depending on the type of computer you have, your screen may look slightly different.
6 Open the Functions menu and choose Update Driver.
A message says the new driver won’t be available until you restart your computer.
7 Restart your computer.

Warning  Be careful not to click the Initialize button; clicking Initialize erases the 
contents of your hard disk. If you inadvertently click Initialize, a dialog box appears telling 
you about the initialization process. Click Cancel.
If you can’t update your hard disk driver

m The hard disk may have been formatted with a third-party utility. Contact the 
manufacturer of the utility for the latest version of the driver.

m Your hard disk driver may be newer than the version supplied in Drive Setup. To check 
the version of the hard disk driver, select the hard disk and choose Get Info from the File 
menu. The version number appears in parentheses next to the word “Where” in the Info 
window.
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m Your hard disk may not contain partitioning information which it needs in order to start 
up properly. To find out, select the disk, then open the File menu and choose Get Info. If 
“Macintosh HD, AT_O” appears next to the word “Where” in the Info window, the disk 
doesn’t contain partitioning information.

You need to reinitialize the hard disk using Drive Setup. See “Initializing a Hard Disk,” 
next. Once you’ve done that, you can update your hard disk driver.

m PowerBooks:  You may have password protection turned on. Turn this off in the Password 
Security control panel, then try updating the hard disk driver again.

Initializing a Hard Disk

The hard disk inside your computer was initialized (formatted for use) at the factory, so you 
should only need to initialize it if your hard disk is damaged and can’t be repaired with Disk 
First Aid (or another disk repair program). 

You can initialize your internal hard disk using a program called Drive Setup, which is on the 
software install CD that came with your computer.

Note:  If your hard disk is not an Apple hard disk, you may need to use the disk utility 
software provided by the disk’s manufacturer instead of Drive Setup. For more information, 
contact the manufacturer of the hard disk.
1 Make sure the Caps Lock key is not engaged.

2 Start up your computer from the software install CD. (See Chapter 2, “Starting Up From a 
CD,” on page 25.)

3 Locate the Utilities folder on the software install CD and double-click it to open the folder.

4 Double-click the Drive Setup icon to open the program.

Warning  Initializing a disk erases all information on the disk. Before initializing your 
disk, recover all the information you can and copy it to another disk.
 



5 In the list of drives, select the disk you want to initialize.
 

Note:  Depending on the type of computer you have, your screen may look slightly different.
6 Click Initialize.

7 If you want to format your hard disk with Mac OS Extended format, a method of formatting 
hard disks that allows for more efficient use of hard disk storage space, follow the steps 
below:

Important  Computers that use Mac OS 8 or earlier cannot access files on a Mac OS 
Extended disk.
a Click Custom Setup. 

b Select the desired partitioning scheme.

c Open the Type pop-up menu in the Volume Info area and choose Mac OS Extended 
format.

d Resize the volumes, if desired. 

e When you’re ready, click OK.
8 Click Initialize.
If initialization fails, do the following:

a Choose Initialization Options from the Functions menu.

b Click the checkbox next to “Low level format,” so there is a checkmark in the checkbox, 
then click OK.

Choosing this option adds significant time to the initialization process.

Note:  The “Zero all data” option is only necessary in rare cases where data must be 
completely overwritten with zeroes.

c Click Initialize.

d If initialization fails a second time, test your hard disk for damage. See “Testing Your Hard 
Disk for Physical Damage” on page 32. 
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Testing Your Hard Disk for Physical Damage
Note:  Testing the disk can take two hours or more, depending on the size of your disk.
1 Make sure the Caps Lock key is not engaged.

2 Start up your computer from the software install CD. (See Chapter 2, “Starting Up From a 
CD,” on page 25.)

3 Locate the Utilities folder on your hard disk or on the software install CD and double-click it 
to open the folder.

4 Double-click the Drive Setup icon to open the program.
5 In the list of drives, select the disk you want to test.
Note:  Depending on the type of computer you have, your screen may look slightly different.
6 Open the Functions menu and choose Test Disk.

7 When a message tells you that the testing is complete, choose Quit from the File menu.
If the test reveals a problem, the hard disk may need to be reinitialized using the low level 
format option. See “Initializing a Hard Disk” on page 30.

If you still have problems, the hard disk is probably damaged. Consult an Apple-authorized 
service provider for assistance. (If you have a hard disk from another manufacturer, consult 
that manufacturer for assistance.)
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4 Reinstalling Your Computer’s Software
 

If you are having problems with the system software or applications that came with your 
computer, you can replace software in the following ways: 

m reinstall system software—if you encounter system software problems or you want to add 
or remove system software components

m reinstall individual applications—if you inadvertently erased or are having problems with 
an application on your hard disk

m restore your hard disk’s original contents—if you want your computer to have its original 
system software, factory settings, and applications

Reinstalling System Software

The Mac OS Install application lets you reinstall the Mac OS (or specific components of the 
Mac OS) on your computer. This application is located on the software install CD that came 
with your computer. 

Note:  If your computer came with additional software installed, see the Read Me document 
on your software install CD for information about reinstalling this software and any custom 
system software settings on your computer. If you are using a system software CD to reinstall 
the Mac OS, you can’t use it to reinstall any additional software.

Before Installing System Software

Before you begin the installation, do the following:

m Customized settings and preferences:  If possible, make a note of any preferences or 
settings in control panels and applications so you can easily reset them after you restore 
or reinstall your software.

Note:  If you are having problems with your computer, you may not be able to open files 
with preferences or customized settings.
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m Software that runs in the background:  If you are using software that runs in the 
background, such as virus-protection, security, or access control software, turn it off 
before you reinstall system software. For instructions, see the documentation that came 
with the software.

m If you are installing the Mac OS on a PowerBook:  Plug the PowerBook in, open the 
Energy Saver control panel, and set the PowerBook so it doesn’t go to sleep. Turn off 
password protection in the Password Security control panel.
Important  It is highly recommended that you back up the data on your hard disk before 
installing system software. Apple is not responsible for any lost data.
Using the Installer

Note:  If something goes wrong, see “Problems During Installation” on page 38.
1 Start up from the software install CD. (See Chapter 2, “Starting Up From a CD,” on page 25.)

2 Double-click the Mac OS Install icon.
A welcome screen appears that describes the steps in the installation process. 

Click to display more 
information about 
each step.
3 When you’re ready to begin, click Continue. 
The Mac OS Install application guides you through the steps necessary to install the software. 
For help during installation, click the Help button (h) in the upper-right corner of the 
window. If you encounter problems, see “Problems During Installation” on page 38.
 



4 To perform a clean installation, go to “Performing a Clean Installation” on page 36. 
 

In a clean installation, the Installer creates a new System Folder on your hard disk. 
Performing a clean installation can be a complicated and lengthy procedure, but if you are 
experiencing problems or your computer seems slow, it may help.
5 Choose a destination disk from the pop-up menu, then click Select.
A dialog box appears asking if you want to reinstall or add/remove software.
6 Do one of the following:
m To install all the software you need for your computer, click Reinstall and follow the 
onscreen instructions. This is the best choice to solve system software problems.

m To add or remove specific system software components, click Add/Remove. Proceed to 
the next section, “Custom Installation.”

Custom Installation
1 In the window that appears, select a software component to install or remove. 

2 To install or remove specific items within a component, open the “Installation mode” pop-up 
menu and choose Customized Installation, or Customized Removal. 
The Recommended Installation option installs all items within the software component.

Your screen may look 
slightly different.
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3 If you choose Customized Installation or Customized Removal, a list of the available items 
within the software component appears. Select the items you want to install or remove.
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Click the triangle on the left to see individual features within each item. To get information 
about an item, click the box in the right column with the letter i in it.
4 Repeat steps 1–3 for each software component you want to install.

5 When you’re finished, click Start. 
If you see messages about problems with your hard disk, see “Problems During Installation” 
on page 38.
6 When a message appears saying that the installation process finished, click Quit to close the 
program or click Continue to install or remove other software.
Performing a Clean Installation

This section provides instructions for what is commonly called a clean installation of system 
software. A normal system software installation replaces changed system files and adds new 
ones, but leaves other files alone. When you install system software using a clean installation, 
the Installer creates a new System Folder on your hard disk. The old System Folder is 
renamed Previous System Folder. 

Note:  Performing a clean installation does not erase the contents of your hard disk.

Performing a clean installation can be a complicated and lengthy procedure, but if you are 
experiencing problems or your computer seems slow, it may help.
 



 

After you do a clean installation, your computer has a new System Folder. Once you make 
sure your computer is working properly, you’ll need to reinstall any non-Apple extensions, 
fonts, and control panels. If your computer came with software that was already installed, 
some of those programs may need to be reinstalled after you perform a clean installation, 
particularly if those programs rely on files that used to be in the System Folder. For more 
information, see “Reinstalling Individual Applications” on page 41.
1 Write down your Internet settings (from the Modem, TCP/IP, and Remote Access control 
panels).
You’ll need to enter these settings in the control panels once the clean installation is finished.
2 Make sure the Caps Lock key is not engaged.

3 Start up your computer from the software install CD. 
(See Chapter 2, “Starting Up From a CD,” on page 25.)
4 Double-click the Mac OS Install icon to open the Installer.

5 In the Welcome dialog box, click Continue.
The Select Destination dialog box appears.
6 Click the Options button.

7 Click the Perform Clean Installation checkbox to select it, then click OK.

8 Select the destination hard disk, then click the Select button.

9 Click Start to begin the installation.
If you want to customize your installation, click Add/Remove after selecting the destination 
disk, and see “Custom Installation” on page 35.
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A new System Folder is installed on your hard disk. (The old System Folder is renamed 
Previous System Folder.)
10 When the Mac OS Install is finished, restart your computer to make sure it’s working 
properly.

11 Reinstall extensions, fonts, control panels, and other items not installed with the Mac OS 
from their original disks. 
If you don’t have the original disks, you can drag these items one at a time from the Previous 
System Folder to the new System Folder. To make sure the software is compatible with this 
version of the Mac OS, restart your computer after you reinstall each item.
12 After you’re sure that you’ve copied all the items you want to save into your new System 
Folder, delete the Previous System Folder from your hard disk.
If the Clean Installation Didn’t Solve the Problem

You may want to revert to the Previous System Folder so that you do not have to reinstall 
your custom extensions, fonts, control panels, and other items not installed with Mac OS 8. 
To use the previous system again, follow the steps in this section.
1 Locate the active System Folder. It has the Mac OS icon on it.

2 Open the System Folder and move the System file into the Preferences folder. Close the 
System Folder.

3 Rename the System Folder “Clean System Folder.”

4 Rename the Previous System Folder (the one you wish to use again) “System Folder.”

5 Open the newly designated System Folder and double-click the System file. Close the 
window that appears, then close the System Folder.

Warning  This procedure may not work. If it does not, you will have to perform a clean 
installation again.
The Mac OS icon should appear on the System Folder’s icon.
6 Restart your computer.

7 Once you are sure your computer is working properly, drag the Clean System Folder to the 
Trash.
If this doesn’t work, you may have a hardware problem. Consult an Apple-authorized service 
provider. 

Problems During Installation

This section helps you solve problems you may encounter while installing your software.
 



 

You can’t start up the computer using the software install CD.

Your computer located the system software on your hard disk before it located the system 
software on the CD. If you have an external hard disk with system software, the computer 
may locate and start up from that device instead of the CD. 

For information on starting up from a CD, see Chapter 2, “Starting Up From a CD,” on 
page 25. Or, with the CD inserted, open the Startup Disk control panel and click the CD icon. 
Then restart the computer. After you install the software, use the Startup Disk control panel 
to reselect your hard disk, then restart your computer.

An error message appears saying installation couldn’t occur.

m If a message says installation could not occur because a file is open, quit all programs. If 
file sharing is on, turn it off. Then try installing again.

m Restart your computer with virtual memory turned off. To do this, either restart your 
computer from the software install CD (see Chapter 2, “Starting Up From a CD,” on 
page 25) or hold down the Command (x) key until the message “Welcome to Mac OS” 
appears. Then try installing again.

An error message says something is wrong with the hard disk.

m Use a third-party disk repair utility to see if it can repair the disk.
Warning  If you use Norton Utilities, make sure you have version 3.5.2 or later. Using 
earlier versions to repair a Mac OS Extended format hard disk may damage the data on 
the disk.
m If you don’t have a third-party utility, or if that utility can’t repair the disk either, you may 
need to reinitialize the hard disk. See “Initializing a Hard Disk” on page 30.

m After you’ve reinitialized the disk, use the Mac OS Installer to reinstall system software, 
then reinstall your application programs. 

The Installer cannot update the hard disk driver.

m If you have a PowerBook, make sure you’ve turned off password protection in the 
Password Security control panel.

m You may not have an Apple-brand hard disk or you don’t have an Apple-brand computer. 
Use the disk utility recommended by the manufacturer of your computer or hard disk to 
update the drivers on your system before installing Mac OS. Make sure to get the latest 
version of the utility from the manufacturer. An old version will not be able to update your 
disk with the most current driver. 

m You may have previously updated your Apple hard disk with a non-Apple disk utility. You 
need to use the utility you used previously to update the driver again. To ensure a 
successful update, obtain the latest version of the utility from the manufacturer. 
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A message says there’s not enough memory to use the Installer.

m Start up the computer using the software install CD. See Chapter 2, “Starting Up From a 
CD,” on page 25. 

m If the hard disk is your startup disk, the disk cache or RAM disk setting may be set too 
high in the Memory control panel. Open the Memory control panel, set your disk cache 
to the default setting, and reduce or turn off your RAM disk. Then restart the computer. 

A message says your computer doesn’t have enough memory to use the 
software. 

m Contact an Apple-authorized service provider for information about how to purchase 
additional memory.

A message says there’s not enough disk space.

m Make sure you’ve selected the correct drive.

m Make more space available on your hard disk by removing some files from the disk. Make 
backup copies of the files you want to keep. Then drag them to the Trash and choose 
Empty Trash from the Special menu to delete the files. You don’t need to quit the Installer 
in order to delete files from the disk. 

Some of the software you selected may have been successfully installed. The Install 
Software window in the Installer program indicates which software has already been 
installed.

A message says the System file cannot be modified. 

m Make sure you’ve selected the correct disk as your destination disk.

m You may have installed virus-protection or security software that guards against 
modification of the System file. Start up your computer from the software install CD. See 
Chapter 2, “Starting Up From a CD,” on page 25. You can also drag any virus-protection or 
security software out of the System Folder and restart your computer. You can put the 
virus-protection software back after installation.

m The System file or the Finder file may be locked. To see if your System file or Finder file is 
locked, select the file’s icon. Then open the File menu and choose Get Info. If a 
checkmark appears in the checkbox next to “Locked,” the file is locked and cannot be 
deleted or replaced. To unlock the file, click the checkbox to deselect it.

m The System file may be corrupted. Perform a clean installation (see “Performing a Clean 
Installation” on page 36).

m You may have file sharing turned on. Open the File Sharing control panel and turn it off.

A message says an item cannot be replaced. 

m The Installer is attempting to replace a file, but there is a folder on the disk that has the 
same name as the file being replaced. Find the folder on your disk and rename it, then try 
the installation again.
 



 

m The file may be corrupted. You need to move or delete the file.

m You may have file sharing turned on. Open the File Sharing control panel and turn it off.

m You may have virtual memory turned on. Open the Memory control panel and turn virtual 
memory off.

m Start up from the software install CD (see Chapter 2, “Starting Up From a CD,” on 
page 25) and try reinstalling system software again.

A message says the installation was not successful. 

You may have an incompatible item in your System Folder. Start up your computer using the 
software install CD. See Chapter 2, “Starting Up From a CD,” on page 25. Then, try doing a 
clean installation. See “Performing a Clean Installation” on page 36.

Reinstalling Individual Applications

If you’re having problems with an application or it was damaged or inadvertently erased, try 
reinstalling that application. If an application came with its own CD, see the software 
documentation or the Read Me document on that CD for instructions on how to reinstall the 
application software.
Important  If you can, make a note of any preferences or settings for your applications 
before reinstalling them so that you can easily reset the preferences and settings after 
reinstallation.
Restoring All Original Software

Some computers come with a software restore CD, which contains the Apple Software 
Restore application. This application lets you restore all your original software, including the 
system software, factory settings, and applications that came with your computer. You have 
the option of erasing your hard disk before restoring the original software, or just replacing 
the original software (Restore In Place).

Before Restoring Your Software

Before you begin the restore process, do the following:

m Customized settings and preferences:  If possible, make a note of any preferences or 
settings in control panels and applications so you can easily reset them after you restore 
your software.

m Software that runs in the background:  If you are using software that runs in the 
background, such as virus-protection, security, or access control software, you should 
turn it off before you reinstall system software. For instructions, see the documentation 
that came with the software.
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m If you are restoring software on a PowerBook:  Plug the PowerBook in, open the Energy 
Saver control panel, and set the PowerBook so it doesn’t go to sleep. Turn off password 
protection in the Password Security control panel.
Important  It is highly recommended that you back up the data on your hard disk before 
restoring software. Apple is not responsible for any lost data.
Restoring in Place

This procedure replaces only your original software (original system software, factory 
settings, and applications that came with your computer) with new copies from the CD, 
leaving everything else on your disk untouched.
1 Start up your computer from the software restore CD and open the Apple Software Restore 
application.

Important  Your preferences may be reset to their original factory defaults, and if you’ve 
already registered software, this procedure may modify that data.
For instructions, see Chapter 2, “Starting Up From a CD,” on page 25.
2 Click the OK button on the introductory screen.

3 If necessary, click Switch Disk to choose the disk on which you want to restore your 
software.

4 Click the checkbox next to Restore In Place.

5 Click Restore.

6 An onscreen message shows the status of the restore process.

7 Click Quit when the process is complete.
Erasing Your Hard Disk

This procedure completely erases the contents of your hard disk before restoring the original 
contents (original system software, factory settings, and applications that came with your 
computer). 
1 Start up your computer from the software restore CD and open the Apple Software Restore 
application.
For instructions, see Chapter 2, “Starting Up From a CD,” on page 25.
2 Click the OK button on the introductory screen.

3 If necessary, click Switch Disk to choose the disk on which you want to restore your 
software.

4 Click the checkbox next to “Erase your hard disk before restoring.”
 



5 If necessary, choose the disk format you want from the Volume Format pop-up menu.
 

The recommended option is “Same as selected configuration” because it restores your hard 
disk to the Mac OS Extended format. This format provides more efficient storage, especially 
on large disks.
6 Click Restore.

7 Click OK.

8 An onscreen message shows the status of the erase and restore process.

9 Click Quit when the process is complete.
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5 Contacting Apple for Help
 

If this handbook has not helped you solve your computer’s problem, try getting information 
from Apple’s product support site on the World Wide Web. See the next section, “Obtaining 
Information via the World Wide Web.”

If you can’t find answers on the support Web site, or don’t have access to the Web, contact 
Apple for assistance. For information on how to contact Apple, see the service and support 
card that came with your computer. Before you contact Apple, see the section “Have This 
Information Available Before Calling.” 

Obtaining Information via the World Wide Web

Apple provides substantial information online for its customers. If you have access to the 
World Wide Web ( WWW ), you may want to check the information in the support area before 
you call Apple. Support information can be found at the following Uniform Resource Locator 
(URL):

m www.apple.com/support

At Apple’s support Web site, you’ll find

m Apple software updates

m Tech Info Library—a searchable database of easy-to-read articles

m Tech Exchange—a resource for product-specific information and support, including a 
discussion forum and the latest news
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Have This Information Available Before Calling

Have the following information and software available when calling Apple: 

m your support access number (see the service and support information that came with 
your computer)

m a description of the problem (for example, the computer freezes in only one application 
or at startup)

m what you have tried to do already

m the type of computer you’re using, along with the amount of RAM installed and size of the 
hard disk

m the serial number of your computer

m the version of system software, third-party software, external devices, and so on 
(especially if the problem involves something you have added to the computer)

m the software install CD

Be in front of the computer when you call so you can take steps the technician suggests. 

Using the Apple System Profiler

If you are able to start up your computer, the Apple System Profiler provides information 
about your computer that will help you troubleshoot your computer.

To open the Apple System Profiler:
1 Choose Apple System Profiler from the Apple (K) menu.
A system profile window appears.
2 Use the commands in the Commands menu or click the tabs in the system profile window to 
get more specific information about the hardware and software used by your computer.
m To find out what the items in the Apple System Profiler window mean, choose Show 
Balloons from the Help menu. Then point to the item you want to know about.

m The New Report command in the File menu lets you create a customized report of system 
software information. You can print this report by choosing the Print command from the 
File menu.
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